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Overview 
 
The intent of Intermediate Corridor Modeling is to take a basic model/corridor and further develop it 
by adding turn lanes, pavement tapers, and non-typical end conditions. The concept of design intent 
will also be introduced and applied where applicable. In addition to the Corridors Ribbon and the 
Corridor Objects Dialog, the Geometry Ribbon will also play a major role throughout the Intermediate 
Corridor Modeling module. During the exercise, various template point overrides will be introduced 
and applied to override the template point defaults. These overrides will result in the corridor’s 
manipulation. 
 

Corridors Ribbon 

Geometry Ribbon 

Corridor Objects Dialog 
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Key Concepts, Tools and Terminology 

 
Design Intent 
Design Intent is the act of preserving rules and relationships established during the design process in 
order to realize downstream benefits of automatic updates. 
 

Template Point Constraint Overrides 
The location of a template point can be overridden using the various methods shown below. This 
functionality allows a single template to produce a number of results.  
 

• Parametric Constraints - Used to override a default template point constraint within a 
defined station range.  

 

• Horizontal Feature Constraints - Each template point can be assigned one Horizontal Feature 
Constraint that can be used to override the default template point constraint. Horizontal 
Feature Constraints will also override Parametric Constraints. 

 

• Point Controls - Can be applied to any point on a template. A Point Control will force the 
template point to follow a specific linear geometric element. Point Controls will override 
Parametric Constraints and Horizontal Feature Constraints. 

 
Key Stations 
A Key Station may be required when a special circumstance of the project occurs that is not 
coincident with the template interval, requiring additional processing by the corridor. 

 
Feature Definition Toggle Bar  
Activates and deactivates settings that impact a variety of Geometry tools. 

 
Civil AccuDraw Toolbar 
Accesses AccuDraw commands. 
 

    
FEATURE DEFINITION 

TOGGLE BAR 
CIVIL ACCUDRAW 

TOOLBAR 
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Intermediate Corridor Modeling Exercise 
 
In this exercise, you will learn how to take a basic model/corridor and further develop it by adding 
turn lanes, pavement tapers, and non-typical end conditions. You will also be introduced to the 
concept of Design Intent. Design Intent is the act of preserving the rules and relationships used 
during the design process in order to maximize the downstream benefits of automatic updates. 
Throughout this exercise, you will be working with NCDOT 2D dgn files exclusively. All design and 
corridor manipulation will be carried out within a 2-dimensional design plane. 
 
1. Launch OpenRoads Designer CONNECT Edition 
             Double-click on the NCDOT Roadway OpenRoads icon on your desktop to launch 
             OpenRoads Designer into the NCDOT Roadway workspace. 
 
2. Set the Workspace and Workset 
             Select DOT-US North Carolina from the Workspace menu. 
             Select NCDOT R-2635C (Training) from the Workset menu. 

 
 
 
 
 
 

3. Open the Y8 Corridor (CMD) dgn file and zoom in closely to the Y8 Corridor 
A. Click the browse button and path to the Module 10 (Intermediate Corridor Modeling) 

folder and open the R-2635C-RDY-CMD-Y8.dgn file. 
B. Zoom in near the Y8 alignment as shown below. Notice that the Y8 alignment already has a 

base corridor. This base Y8 corridor will serve as a starting point for the Intermediate Corridor 
Modeling exercise.  See the Initial Corridor Modeling Module for detailed instructions for 
initial corridor development 

Note: All reference files that are required for the intermediate Corridor Modeling module 
have already been attached to the R-2635C-RDY-CMD-Y8.dgn file. 

… 

Y8 
  CORRIDOR 

TEMPLATE 
DROP 2 

TEMPLATE 
DROP 1 
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4. Review the Y8 Corridor Template  
A. Click the Create Template button (Corridors > Create > Template > Create Template) 
B. Under the Project Templates folder, select the Y8_DF - 2+2 Lanes AUX Raised Median 

ADSS template as shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

C. Notice a few of the key Y8_DF - 2+2 Lanes AUX Raised Median ADSS template points as shown 
below. Each of these will be used throughout the Intermediate Corridor Modeling exercise.  

 
 
 

 
 
 
 
 
 
 
 
 

 

1R 1L 

2R/3R 
4R 5R 4L 5L 

1R. +TR_ETO_SHEAR 
2R. +ETI 
3R. +LN1 
4R. +ETO 
5R. +GSO_N 

2L/3L 

1L. ~TR_ETO_SHEAR 
2L. ~ETI 
3L. ~LN1 
4L. ~ETO 
5L. ~GSO_N 

Y8_DF - 2+2 LANES AUX 
RAISED MEDIAN ADSS 

TEMPLATE 
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D. Examine a brief description of each of these key template points below. The following 
Parametric and Horizonal Feature Constraints associated with these points will be used 
throughout the Intermediate Corridor Modeling exercise.   

 
1. +/~TR_ETO_SHEAR = Target Edge of Travel Outside Shear Null Point 

• Parametric Constraint = PV_Shear_Outside RT/LT 

• Horizontal Feature Constraint = CCE_Target_Shear_Out_RT/LT 
 

2. +/~ETI = Edge of Travel Inside Template Point 

• Parametric Constraint = LN_AUX Inside Width RT/LT 

• Parametric Constraint = LN_AUX Inside Slope RT/LT 

• Horizontal Feature Constraint = CCE_Target_EOT_In_RT/LT 
 

3. +/~LN1 = Lane 1 Template Point 

• Parametric Constraint = MD_Tie Offset 
 

4. +/~ETO = Edge of Travel Outside Template Point 

• Parametric Constraint = LN_AUX Outside Width RT/LT 

• Parametric Constraint = LN_AUX Outside Slope RT/LT 

• Horizontal Feature Constraint = CCE_Target_EOT_Out_RT/LT 
 

5. +/~GSO_N – Grass Shoulder Outside Normal Template Point 

• Parametric Constraint = SHO_Width Normal  

• Horizontal Feature Constraint = CCE_Target_GS 
 

E. Close out of the Create Template dialog. 
 
5. Load Civil AccuDraw and the Feature Definition Toggle Bar 

A. Click on the Civil AccuDraw button (Geometry > General Tools > Civil Toggles > Civil 
AccuDraw) to load the Civil AccuDraw toolbar.  

B. Click on the Feature Definition Toggle Bar button (Geometry > General Tools > 
Standards > Feature Definition Toggle Bar) to load the Feature Definition Toggle 
Bar. 

 
Hint: Both of these toolbars will be used throughout the design/modeling process. Because of  
this, it’s recommended that both are docked for easy access.  
 
 

CIVIL ACCUDRAW 
TOOLBAR 

FEATURE DEFINITION 
TOGGLE BAR 
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6. Widen the Y8 Corridor median from 30’ to 46’ using a Parametric 
Constraint 
A. Click the Corridor Objects button (Corridors > Edit > Corridor Objects) 

and select the Y8 Corridor as shown below when prompted to load the  
Corridor Objects dialog. 

 
 
 
 
 
 
 
 
 

B. From the Parametric Constraints row, click the Add New button as shown below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

C. Key the following parameters into the Create Parametric Constraint dialog. 

• Start = 19+10.00 

• End = 23+50.00  

• Constraint Label = MD_Tie Offset 

• Start Value = 15.0000 

• Stop Value = 23.0000 
 

Add New 

CORRIDOR 
OBJECTS 

Y8 
  CORRIDOR 
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D. This will add a median taper and be the first of two (2) parametric constraints necessary to 
widen the median to 46’. 

 
 
 
 
 
 
 
 
 
 

 
E. To better view the changes being made to the Y8 corridor, right-click and hold to load the 

View Control menu. From there, select the 2 Views Plan/3D option as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 

F. This will load the View 2, Default-3D view in addition to the standard View 1, Default view as 
shown below. As you add parametric constraints, this view can help  visualize the changes 
being made to the Y8 corridor.  

 

MEDIAN 
TAPER 

MEDIAN 
TAPER 

30’ MEDIAN 
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G. Now, add the following parametric constraint to finish widening the Y8 corridor median to 46’  

• Start = 23+50.00 

• End = Lock to End  

• Constraint Label = MD_Tie Offset 

• Start Value = 23.0000 

• Stop Value = 23.0000 
 

H. The 46’ median has been finalized as shown below. Keep the Corridor Objects dialog open. 

 
7. Add a right turn and bay taper using a Parametric Constraint 

A. Add the following Parametric Constraint using the Corridor Objects dialog. This will add a 12’ 
turn lane on the outer left side of the corridor. 
 

• Start = 17+65.00 

• End = 21+65.00  

• Constraint Label = LN_AUX Outside Width LT 

• Start Value = -12.0000 

• Stop Value = -12.0000 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FINALIZED 46’ 
MEDIAN 

MEDIAN 
TAPER 
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B. Notice the right turn bay has been added to the corridor as shown below. 
 

 
  
C. To finalize the the right turn, add a bay taper using the following Parametric Constraint. 

• Start = 21+65.00 

• End = 22+65.00  

• Constraint Label = LN_AUX Outside Width LT 

• Start Value = -12.0000 

• Stop Value = 0.0000 
 

D. The bay taper has been added and the right turn has been finalized. See below. 

 
 

400’ RIGHT 
TURN BAY 

100’ BAY 
TAPER  

FINALIZED 
RIGHT TURN 



 

Module 10 – Intermediate Corridor Modeling 
 

 
 

Page | 12  
 
 

E. Notice that each of the previous parametric constraints are now listed within the Y8 Corridor 
Objects dialog as shown below. At any time, these values can quickly be changed to reflect  
changes to the design. 

 

 
 

F. Modify bay taper length by keying in +50 to the End Station parameter as shown below. 
 
 
 
 
 
 

 
` 
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G. Notice that the End Station parameter now reads 
as 23+15.00, adding an additional 50’ to the end 
station. This additional 50’ is also reflected in the 
corridor as shown below. 

 
 
 

 
 

 
 
 
 
 
 
 
 

 
 

H. Close out of the Corridor Objects dialog. 
 
8. Add a left turn and bay taper using a Horizontal Feature Constraint 

A. With both 2D and 3D views displayed, load the References dialog as shown below. 
 

 
 

BAY TAPER 
EXTENDED BY AN 
ADDITIONAL 50’   

VIEW 1, 
DEFAULT 

VIEW 2, 
DEFAULT 3D 
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B. Now, click back and forth between the two (2) views. Notice that the Refences dialog 
switches to display the files attached the current view in focus. With the View 1, Default 
view in focus, turn the display of the Default-3D view off as shown below.  

 
  
C. Notice that the 3D model has been turned off, leaving just the linework and the corridor 

object as shown below.  

CORRIDOR 
OBJECT 

VARIOUS 
LINEWORK 

VARIOUS 
LINEWORK 
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D. Depending on your prefence, you may choose to turn off additional linear elements to avoid 
confusion as shown below. The levels displayed below are necessary for design/modeling and 
should remain on as you design/model. 

 
 

E. Next, click the Toggle Civil AccuDraw button ON, set Station-Offset as the active Read-
Out, and select the first template drop that begins at station 10+00.00 using the 
Element Selection tool as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PROP CORRIDOR 
GRAPHICS DESIGN 

PROP TL EDGE 
OF TRAVEL 

PROP PAVED 
SHOULDER 

PROP TL GRASS 
SHOULDER NORMAL 

PROP HORIZONTAL 
ALIGNMENT 

TEMPLATE 
DROP 

TOGGLE CIVIL 
ACCUDRAW ON 

STATION-OFFSET 
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F. Now, click on the trailing template drop arrow shown below and drag the template back and 
forth. Notice the Civil AccuDraw dialog displaying the station/offset data as it tracks your 
movement. 

  
  
 

 
G. Key station 16+00.00 into the Civil Accudraw dialog and press Enter. Notice that the corridor 

and all linework associated with it now end at station 16+00.00 as shown below. Then toggle 
Civil Accudraw to OFF. 

 
 

 
 
 

 
 
 
 
 
 

 

 

 

TEMPLATE 
DROP ARROW 

CIVIL ACCUDRAW 
DIALOG 

CIVIL ACCUDRAW 
DIALOG 

TOGGLE CIVIL 
ACCUDRAW OFF 
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H. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 
button and then select the CCE_Target_EOT_In_RT feature from the (Linear > Roadway > 
Construction Class Element) folder as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Horizontal features used for targeting are stored within the Construction Class Element 
folder.  
 

I. Notice the CCE_Target_EOT_In_RT feature naming convention as shown below. 
 
 
 
 

 
 
 
 
 
 
 
 
 
Note:  
Construction Class Elements are a type of feature commonly used for corridor manipulation but 

not considered part of the actual model.  

 
  

FEATURE 
DEFINITION 
DROPDOWN 

USE ACTIVE 
FEATURE 

DEFINITION 

     CCE_Target_EOT_In_RT 

CONSTRUCTION 
CLASS ELEMENT 

USED FOR 
TARGETING 

EDGE OF 
TRAVEL 

INSIDE PAVEMENT OF 
DIVIDED FACILITY 

RIGHT SIDE OF 
DIVIDED FACILITY 
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J. From the Geometry tab, select the Single Offset Partial tool (Geometry > Horizontal > Offsets 
and Tapers > Single Offset Partial)  and then select the Y8 alignment when prompted to 
locate element.  

 
 

 
K. After selecting the Y8 Alignment, the heads-up prompt displays and tracks your movements. 

Notice the  two (2) arrows that are included within the prompt.  These arrows represent 
additional constraints. To toggle back and forth between these constraints, simply click the 
arrow keys on your keyboard. In addition to the heads-up prompt,  a Single Offset Partial 
dialog box also loads. As you toggle back and forth between the constraints, notice that they 
match the  Single Offset Partial dialog constraints. A combination of prompts and dialog 
boxes similar to the ones shown below will be used throughout the design/modeling process.   

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

ADDITIONAL 
CONSTRAINTS 

HEADS-UP PROMPT 
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L. With the Parameters Offset prompt toggled on, key-in 3.0000 and press Enter. Notice the 
Lock that displays after you press Enter as shown below. This indicates that the  offset 
parameter has been locked. As you move your mouse back and forth, notice the red dotted 
line tracks with your movements but the offset remains at 3’. If you move your mouse to the 
left side of the alignment, notice that the red line also moves and the offset now reads as -3’. 
The red dotted line represents the CCE_Target_EOT_In_RT that was previously set as the 
active feature. 

 
 
 
 
 
 
 
 
 

 

M. Next, toggle to the Distance: Start Distance parameter using your keyboard’s arrow key, then 
key in 16+00.00 and click “Enter” to lock the Start Station as shown below. Notice that these 
same Single Offset Partial dialog parameters have also been locked. The “End” key can be 
used to unlock any of the parameters that have focus if needed.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Hints: Either of these can be unlocked or modified using the dialog box as well. 

A CHECK ED BOX INDICATES A 
LOCKED CONSTRAINT 

OFFSET CONSTRAINT 
HAS BEEN LOCKED 

CCE_TARGET_EOT_IN_RT 
OFFSET 3’ FROM Y8 Y8 ALIGNMENT 

Key-in 3.0000 

START CONSTRAINT 
HAS BEEN LOCKED 

KEY-IN 16+00.00 
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N. After both Single Partial Offset start constraints have been locked, left click the screen to 
accept. You will then be prompted for a stop location. There are two (2) Stop Constraint 
options to choose from: Length or Station.  Using  your keyboard arrow keys, toggle back and 
forth between the two. In this instance, choose the Distance:End Distance (Station) 
constraint. Key-in station 13+00.00 and press Enter to lock as shown below.  

 
 
 
 
 

O. Next, left-click the screen to accept the Distance:End Distance constraint. This will place the 
CCE_Target_EOT_In_RT linear element and finalize the left turn lane edge of pavement 
Construction Class Element placement. Immediately after placing this line, you will be asked 
by the prompt if you would like to Mirror. In this instance, key-in N for no, finishing the Single 
Offset Partial command. 

  
 
 

CCE_TARGET_EOT_IN_RT  
OFFSET 3’ FROM Y8  

BEGINS AT STATION 16+00 
ENDS AT STATION 13+00 

FINALIZED 
CCE_TARGET_EOT_IN_RT  

Key-in N FOR NO 

DISTANCE: END DISTANCE 
HAS BEEN LOCKED 

Key-in 13+00.00 A CHECK ED BOX INDICATES A 
LOCKED CONSTRAINT 
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P. Zoom in close to the CCE_Target_EOT_In_RT line that was just placed and click on it using 
the Element Selection tool. Notice the on-screen constraints displaying stationing, offset, 
and length in relation to the Y8 Alignment as shown below. Each of these constraints 
indicate a rule and can be edited on screen by simply clicking and editing the text.  

 

 
Q. Click on the begin station text that reads 13+00.00 and change it to read 12+50.00. Notice 

that the CCE_Target_EOT_In_RT has been extended by an additional 50’ and the length label 
now reads 350’ as shown below. All of these pieces of geometry are tied to one another 
through a rule. Because of this relationship, if one is changed, all of the others are impacted 
as well. This is the key to rules-based design intent.  

 
R. Next, check to make sure that the Persist Snaps and Rule button is toggled on as shown 

below and then select the Variable Offset Taper tool (Geometry > Horizontal > Offsets and 
Tapers > Variable Offset Taper) and again, select the Y8 alignment when prompted to locate 
element. 
 

 
 

 
 

PERSIST SNAPS AND 
RULE TOGGLED ON 

FEATURE DEFINITION 
TOGGLE BAR 

12+50 350’ 

Y8 ALIGNMENT 

300’ 

3’ 

13+00 16+00 

3’ 

3’ 

Y8 ALIGNMENT 

CCE_TARGET 
_EOT_IN_RT  

CCE_TARGET 
_EOT_IN_RT  
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S. Now, key-point snap to the end of the previously drawn CCE_Target_EOT_In_RT element 
and key the following parameters into the Variable Offset Taper dialog. Then, left-click on the 
screen to accept, drawing in the left turn lane bay taper as shown below. Choose not to 
mirror the bay taper when finishing the Variable Offset Taper command.  

• End Offset = 15.0000 

•  Length = 100’ 

 
T. Next, click on the finalized bay taper as shown below and notice the various rule based 

constraints as well as the Key-Point Snap icon. Any time that you snap to an element 
while the Persist Snaps and Rule button is toggled, you create a rule and a relationship 
between the two (2) elements. This establishes a parent-child relationship. In this case, 
the lane line is the parent and the bay taper is the child. 

Note: In some scenarios, this parent-child relationship may be less than desirable but the 
need to snap may still persist. In this case, toggle off the Persist Snaps and Rule option.          

Y8 ALIGNMENT 
KEY-POINT SNAP HERE 

TO BEGIN THE VARIABLE OFFSET TAPER 

END OF VARIABLE OFFSET TAPER 
BASED ON ITS ORIGIN SNAP, LENGTH AND 

END OFFSET PARAMETERS 

KEY-POINT SNAP 
CREATES A RULE 

LANE LINE 
IS PARENT 

BAY TAPER LINE  
IS CHILD PERSIST SNAPS AND 

RULE TOGGLED ON 
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U. To demonstrate the parent-child relationship between the left turn lane and its bay taper, 
change the length of the left turn lane to 300’ as shown below. Notice that the bay taper is 
also adjusted. This is based on the rule that was established when the bay taper was snapped 
to the end of the lane line during its creation. 

 
 

 
V. After adding the left turn lane and bay taper geometry, turn the Default-3D model back on 

using the references dialog. Notice that the corridor is not recognizing the new geometry  and 
has not changed. To resolve this, the newly added geometry will need to be added to the 
corridor as a corridor reference. To add a corridor reference, click and hover over one of the 
corridor object handles to display the corridor menu. From the menu, select the Add Corridor 
Reference option as shown below. 
 

 
 
 
 
 
 

 
 
 

 
 
 
 
 
 

 
 

THE BAY TAPER 
ADJUSTS LANE LINE LENGTH 

CHANGED TO 300’ 

CORRIDOR 
OBJECT 
HANDLE 

ADD 
CORRIDOR 
REFERENCE 
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W. Next, select the two (2) new pieces of geometry and then right click to complete. Once the 
corridor finishes processing, it will be updated to include the left turn lane and bay taper as 
shown below. 

 

 
 
 

X. The Left turn lane and bay taper have been added to the Y8 corridor using the 
CCE_Target_EOT_In_RT horizontal feature constraint. For a better perspective, open 
the View 2, Default-3D view as shown below. 

 
 

 
 
 
 
 
 

BAY TAPER   LEFT TURN LANE   

FINALIZED LEFT TURN  
LANE AND BAY TAPER   
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9. Add a right turn and bay taper using a Point Control 
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 

button and then select the CCE_Target_1 feature from the (Linear > Roadway > Construction 
Class Element) folder. Notice the additional CCE_Target features as shown below.  
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
Note: By definition, the intent of a point control is to control points. Unlike a Horizontal 
Feature Constraint, which is template based and pre-determined, a point control could be 
used to control any number of the points that make up a template. For this reason, the 
CCE_Target features provided by NCDOT are more generic in nature and a good choice for 
use with a point control. 

 
B. From the Geometry tab, select the Single Offset Partial tool (Geometry > Horizontal > Offsets 

and Tapers > Single Offset Partial)  and then select the Y8 alignment when prompted to 
locate element.  

 
 

Note: Construction class elements used for template targeting should be created using offsets 
and tapers from the corridor alignment or other non-template based elements to avoid what 
is known as a circular reference. Circular references cannot be targeted by the template, 
making them unusable. 

CCE_TARGET  FEATURES  
FOR POINT CONTROLS 

USE ACTIVE 
FEATURE 

DEFINITION 
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C. Key the following parameters into the Single Offset Partial dialog and then click through the 
prompts to accept. This will draw the outside edge of travel for the right turn lane. 

• Offset = 51.0000 

• Use Spiral Transitions = Unchecked 

• Start Distance = 16+00.00 

• End Distance = 12+00.00 
 

Notice the Name attribute within the Single Offset Partial dialog as shown below. As you 
design using the Open Roads Civil Tools, civil geometry elements will be named automatically 
based on the Feature.  

 
 
 
 
 
 

 
 
 

 
 

D. Next, select the Ratio Offset Taper tool (Geometry > Horizontal > Offsets and Tapers > Ratio 
Offset Taper) and again, select the Y8 alignment when prompted to locate element. 

E. Key the following parameters into the Ratio Offset Taper dialog or as prompted by the 
heads-up display. 
 

• Ratio = 8.33:1  
 

 
 

 
F. Then Key-Point snap to the end of the right turn lane, creating a rule that will control the start 

location. 
 

 
 
 
 
 
 

AUTOMATIC NAMING OF 
GEOMETRIC ELEMENTS 

BASED ON FEATURE  

KEY-POINT SNAP TO 
CREATE RULE 
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G. Next, drag your mouse to the left beyond the default outside edge of travel and click the 
screen to finish the Ratio Offset Taper command. Again, no need to mirror in this instance.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
H. Now, trim the Ratio Offset Taper to the default outside edge of travel using the Trim to 

Element command (Drawing > Modify > Trim to Element) . This will create another rule that 
dictates that the taper will end at the default outside edge of travel.   

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

EXTEND THE RATIO OFFSET 
TAPER BEYOND THE CURRENT 

OUTSIDE EDGE OF TRAVEL  DEFAULT OUTSIDE 
EDGE OF TRAVEL  

TRIM TO 
ELEMENT  

TRIM TO DEFAULT  
OUTSIDE EDGE OF 

TRAVEL CREATES A RULE  

DEFAULT OUTSIDE 
EDGE OF TRAVEL  
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I. Next, add a point control using the Create Point Control option (Corridors > Edit > Edits > 
Create Pont Control) as shown below. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
J. After selecting the Y8 Corridor, key the following parameters into the Create Point 

Control dialog and click through the prompts to accept.  
 

• Start = Lock to Start 

• Sop = Lock to End 

• Control Description = RT OUTSIDE EDGE OF 
TRAVEL 

• Point = +ETO 

• Mode = Horizontal  

• Control Type = Feature Definition 

• Feature Definition = CCE_Target_1 

• Range = 0.0000 

• Priority = 1 

• Horizontal Offset Start = 0.0000 

• Horizontal Offset Stop = 0.0000 

• Use as Secondary Alignment = Unchecked 
  

 
 

Note: This will create a single point control that runs the length of the Y8 Corridor. This point 
control will be initiated If a piece of geometry is referenced to the corridor with the 
CCE_Target_1 feature assigned to it. 
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K. Notice the purple dashed line shown below  that is now displayed. This line represents the 
RT OUTSIDE EDGE OF TRAVEL point control that was just created.  

 
 
 
 
 
 
 
 
 
 
 

Note: Like other objects created using OpenRoads technology, point controls can easily be 
edited using the Corridor Objects dialog or by clicking and selecting one of the context menu 
options. 
 

L. Next, use the Add Corridor Reference tool and add the right turn lane and bay taper to the Y8 
Corridor as a Corridor Reference.  

 
 
 
 
 
 
 
 

 
M. In the View 2, Default-3D view, notice that the right turn lane and bay taper have been added 

to the Y8 corridor as shown below. 
 

 
 
 
 
 
 
 
 
 

RT OUTSIDE EDGE OF 
TRAVEL POINT CONTROL 

ADD CORRIDOR 
REFERENCE 

FINALIZED RIGHT TURN  
LANE AND BAY TAPER   
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10. Use a Parametric Constraint to shear the template at the edge of travel 
A. Select the Create Parametric Constraint option (Corridors > Edit > Edits > Create Parametric 

Constraint) as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B. Click on the Constraint Label drop-down from the Create Parametric Constrain dialog and 
notice the four (4) PV_Shear options. Each of these can be used for shearing pavement at the 
edge on travel. In this instance, select the PV_Shear Outside RT option as shown below. 
 
 
` 
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C. After selecting the PV_Shear Outside RT Constraint Label from the drop-down, key the 
following additional parameters into the Create Parametric Constraint dialog and click 
through the prompts to accept.  

 

• Start = 36+00.00 

• Stop = 39+00.00 

• Constraint Label = PV_Shear Outside RT 

• Start Value = 50.0000 

• Stop Value = 50.0000 
 

 
 
 
 

 
D. Now, zoom in closely to the shear location as shown below. As expected, elements beyond 

the outside edge of travel have been removed as a result of the PV_Shear Outside RT 
parametric constraint. You may notice, however, that the station range of the elements 
removed does not match the PV_Shear Outside RT station range. However, the yellow 
Corridor Object does match the PV_Shear Outside RT station range.  

 
Note: When conditions occur that are not coincident with the project template interval, it 
might be desirable to include an additional station or stations for processing. 

 
 

STATION 
36+00.00 

STATION 
39+00.00 

CORRIDOR 
OBJECT  
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E. This can be resolved by adding what is called a Key Station. Select the Create Key Station 
option (Corridors > Edit > Edits > Create Key Station) as shown below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
F. Create two (2) Key Stations as shown below. Notice that the Key Stations nearly match the 

station parameters for the PV_Shear Outside RT Horizontal Feature Constraint. Key Stations 
should be placed as close as possible but not directly on top of conditions that need to be 
picked up by the corridor.  
 

• Key Station 1 = 35+99.99 

• Key Station 2 = 39+00.01 
 

 
 

KEY STATION 
35+99.99 

KEY STATION 
39+00.01 
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G. Notice that the Key Stations did in fact resolve the issue. The Y8 Corridor now reflects the 
intent of the PV_Shear Outside RT Parametric Constraint as shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
H. The Y8 Corridor shear has been finalized as shown below. 
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11. Use a Horizontal Feature Constraint to shear the template at the edge of travel 
 

A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 
button and then select the CCE_Target_Shear_Out_RT feature from the (Linear > Roadway > 
Construction Class Element) folder.  

 
 
 
 
 
 
 
 
 
 
 

B. Next, select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers > 
Single Offset Partial)  and then select the Y8 alignment when prompted to locate element.  

 
C. After selecting the Y8 Corridor, key the following parameters into the Single Offset Partial 

dialog and click through the prompts to accept.  
 

• Offset = 50.0000  

• Start Distance = 40+00.00 

• End Distance = 42+00.00 
 

Note: The offset does not need to be 50’. This number was 
used for simplicity.  
 
 
 
 

USE ACTIVE 
FEATURE 
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FINALIZED 
SHEAR   

D. Next, use the Add Corridor Reference tool to add the  CCE_Target_Shear_Out feature to the 
Y8 Corridor as a Corridor Reference.  

 
 
 
 
 
 
 
 
 

E. Notice that the corridor has been sheared as shown below. Again, notice that the shear does 
not match the CCE_Target_Shear_Out feature perfectly and will require Key Stations to be 
finalized. 
 

 
 
 
 

 
 
 
 
 
 

 
F. Create two (2) Key Stations as shown below.  

 

• Key Station 1 = 39+99.99 

• Key Station 2 = 42+00.01 
 

G. The Y8 Corridor shear has been finalized as shown below. 
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12. Draw Guardrail and TL-3 Anchor units using 3D Linestyles  
A. Select the 2 Views Plan/3D option from the View Control context menu to open the View 

2,Default-3D view in addition to the already opened View 1, Default 2D view.  
 
 
 
 
 
 
 
 
 

B. From the Feature Definition Toggle Bar, toggle the Use Active Feature Definition button 
and set the Guardrail_Right feature (Linear > Roadway > Guardrail and Barrier > 
Guardrail_Right) to active.  

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

C. In the View 1, Default window zoom in closely to the Y8 corridor as show below.  
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D. Now, select the Line Between Points tool (Geometry > Horizontal > Lines > Line Between 
Points) as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 

E. Next, draw a random line in the View 1, Default window as shown below. Notice that model 
has not been updated to reflect the guardrail in the View 2, Default-3D window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

F. This can be resolved by toggling on the Create 3D Automatically option and then redrawing 
the guardrail.  

 
 
 
 
 
 
 

CREATE 3D 
AUTOMATICALLY   

GUARDRAIL DRAWN 
IN THE 2D VIEW   
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G. When the Create 3D Automatically option is enabled, the guardrail which was drawn in the 
2D view of a model will pick up the vertical attribute from the 3D model automatically as 
shown below. 

 
H. Delete the guardrail from the View 1, Default window and notice that it is also removed from 

the 3D model.  
 

I. With the Feature still set to Guardrail_Right and the options still set as shown below, 
select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers > 
Single Offset Partial)  and then select the Paved Shoulder on the right side of the road 
when prompted to locate element. 
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CREATE 3D 
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DEFINITION 
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J. After selecting the Paved Shoulder, key the following parameters 
into the Single Offset Partial dialog and click through the prompts to 
accept. This will place the guardrail .01’ off the paved shoulder line as 
shown below.  
 

• Offset = 0.0100 

• Start Distance = 44+50.00 

• End Distance = 46+50.00 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 

K. Next, set the TL3 Approach RT feature (Linear > Roadway > Guardrail and Barrier > TL3 
Approach RT) to active and toggle the options as shown below. 
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L. Next, select the Ratio Offset Taper tool (Geometry > Horizontal > Offsets and Tapers > Ratio 
Offset Taper)  and then select the Y8 alignment when prompted to locate element.  

 
 
 
 
 
 
 
 
 
 

 
M. Then, key the following parameters into the Ratio Offset Taper dialog and then Key-point 

snap to the beginning of the guardrail. After snapping to the end of the guardrail, adjust the 
location of the TL-3 by moving the mouse back and forth before left-clicking to finalize 
placement.   
 

• Offset = 57.0000 

• Length = 62.0000  
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TL-3 ANCHOR 
UNIT   

KEY-POINT SNAP 
TO CREATE RULE  
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N. After finalizing the TL-3 approach, set the TL3 Trail RT feature (Linear > Roadway > Guardrail 
and Barrier > TL3 Trail RT) to active and toggle the options as shown below. 

 
 

 
 
 
 

 
 
 
 

O. Now, follow the same steps to draw the TL-3 Trailing end. Only this time, set the Ratio 
parameter to 50:1 before Key-Point snapping to the end of the guardrail.  

 
 

 
 
 
 
 
 
 

 
P. Notice that both TL-3 Anchor units along with the guardrail are now visible in the View 2, 

Default-3D window as shown below. 

 

PERSIST SNAPS AND 
RULE 

CREATE 3D 
AUTOMATICALLY   

USE ACTIVE FEATURE 
DEFINITION 

GUARDRAIL   

TL-3 APPROACH 
ANCHOR UNIT   

TL-3 TRAILING 
ANCHOR UNIT  



 

Module 10 – Intermediate Corridor Modeling 
 

 
 

Page | 42  
 
 

13. Widen Grass Shoulder to Accommodate Guardrail and TL-3 Anchor units 
A. First, set the CCE_Target_GS feature (Linear > Roadway > Construction Class Element > 

CCE_Target_GS) to active and toggle the options as shown below. 
 

 
 

B. Then, select the Single Offset Entire Element tool (Geometry > Horizontal > Offsets and 
Tapers > Single Offset Entire Element) and select the guardrail that was added in the 
previous step when prompted to locate element. This will rule the grass shoulder limits to the 
match the guardrail. 

 
 
 
 
 
 

 
 

Note: Construction class elements used for template targeting should be created using offsets 
and tapers from the corridor alignment or other non-template based elements to avoid what 
is known as a circular reference. Circular references cannot be targeted by the template, 
making them unusable.  
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GUARDRAIL   

CCE_TARGET_GS   

C. Set the Offset parameter to 5.0000 within the Single Offset 
Entire Element dialog and click through the prompts to accept. 
The CCE_Target_GS will be used to widen the grass shoulder as 
needed to accommodate the guardrail. 

 
 
 
 
 
 
 
 
 
 

D. Next, select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers > 
Single Offset Partial) and choose the Y8 alignment when prompted to locate element. 

 
 
 
 
 
 
 
 
 

E. Then, set the Length parameter to 65.000 and Key-Point snap to 
the beginning of the CCE_Target_GS line that was created in the 
previous step. Click through the additional prompts to create a 
line that is ruled to be 65’ in length from the beginning of the 
guardrail.   
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F. Next, select the Variable Offset Taper tool (Geometry > Horizontal > Offsets and Tapers > 
Variable Offset Taper) and again, choose the Y8 alignment when prompted to locate 
element. 

 
 
 
 
 
 
 
 
 

G. Then, key the following parameters into the Variable Offset Taper dialog and snap to the 
beginning of the CCE_Target_GS line that was just drawn in the previous step.  
 

• End Offset = 59.0000 

• Length = 25.0000  

 
 

H. Now, follow the same steps to draw the CCE_Target_GS feature at the Trailing end of the 
guardrail. 
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I. The CCE_Target_GS should now cover the full length of the guardrail and TL-3 anchor units as 
shown below. 

 
 
 
 
 
 
 
 

J. Next, use the Add Corridor Reference tool to add the  CCE_Target_GS features to the Y8 
Corridor as a Corridor Reference.  

 
 
 
 
 
 
 
 
 
 
 
 

K. Once the Y8 Corridor processes, notice that the corridor did not completely pick up the 
breaks in the CCE_Target_GS as shown below. 
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L. To resolve this, add four (4) Key-Stations along the CCE_Target_GS feature at each of the 
breaks using Key-Point snaps as shown below. 

 
 

 
 
 

M. In the View 2, Default-3D window, notice the finalized guardrail, anchor units and grass 
shoulder widening as shown below.  
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14. Adjust the Guardrail Station Range to Demonstrate Design Intent 
A. Select the guardrail element as shown below and adjust the begin station to 43+50.00 and 

the end station to 47+50.00.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B. Notice in the View 2, Default-3D window that not only the guardrail, but also the TL-3 
Anchors as well as the grass shoulder that was widened in the previous step, have also been 
updated. This is due to the rules-based design that was leveraged in the previous steps.  

 
Notes:  

• Design Intent is not required, but if used properly can be advantageous to the overall 
design process.  

• A Parametric Constraint can also widen the shoulder for Guardrail.  
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